
WordBasic Macro Examples

MACROS.DOC is a template that contains a collection of macros that you may find useful.

To display a list of these macros, click the List Macros button or use the arrow keys to select the button,
and then press alt+shift+f9.

ANSI Char
Displays the ANSI character codes for the characters within a selection.  Also allows you to print or 
display a list in a new document of the codes within a selection.

App Runner
Brings up a dialog box that allows you to start commonly used applications, such as File Manager, 
Sysedit, Print Manager, and Control Panel.

Bookmark Helper
Helps you manage bookmarks in your documents through two functions:

1. You can list the contents of all bookmarks in a document. 

You can list bookmarks in the order in which they appear in the document, in alphabetic order by 
bookmark name, or in alphabetic order by their contents.

2. You can search for a bookmark name or its contents. 

The macro will list all instances in the order in which the bookmarks are found in the document.

Print Listed Documents (two macros)
The FileNext macro chains documents together for group printing (be sure to supply the full paths to the
document files). 

The FilePrintNext macro prints documents that have been chained together using the FileNext macro 
(be sure to supply the name of the document that was saved or created with the FileNext macro).

Glossary Manager
Copies or moves selected glossary entries from one template to another. You can also use Glossary 
Manager to list selected glossary entries in a new Word document or export them to a text file.

When you run the Glossary Manager macro, the current template name appears in the Source Template 



list, and the glossary entries from this template appear in the Glossaries In Source Template list. The 
following instructions describe how to use Glossary Manager:

1. In the Source Template list, select the template that contains the desired glossary entries. If you select
a different template, choose the Refresh List button to update the Glossaries In Source Template list.

2. In the Destination Template list, select the template into which you want to copy or move the 
selected glossary entries.

3. In the Glossaries In Source Template list, select a glossary entry name. Choose the Select button. An 
asterisk (*) appears next to selected glossary entries. To select all the glossary entries in the list, 
choose the Select All button. To clear a single selection, select the glossary entry and choose the 
Clear button. To clear all selected glossary entries, choose the Clear All button.

Repeat this step until you have selected all the desired glossary entries in the Glossaries In Source 
Template list.

4. Choose one of the following buttons:

Button Description

Copy Copies the selected glossary entries from the source template to the destination
template.

Move Moves the selected glossary entries from the source template to the destination
template.

Delete Deletes the selected glossary entries from the source template.

Report Inserts the glossary name and glossary entry text of each selected glossary 
entry in a new Word document.

Export to 
File

Exports the selected glossary entries to a text file named TEMPGLOS.TXT 
for template glossary entries or GLOBGLOS.TXT for global glossary entries.

5. Choose the Exit button to close the Glossary Manager macro.



Org. Chart
Generates an organizational chart using the outline of the current document. This macro uses the 
heading levels defined in the current document to generate a multilevel organizational chart using the 
table function in Word for Windows. 

To see how the macro operates, do the following:

1. In a new document type the following (end each line with a paragraph mark):

President
Vice President
Secretary
Treasurer

3. Apply the "Heading 1" style to President.

4. Apply the "Heading 2" style to Vice President.

5. Apply the "Heading 3" style to Secretary and Treasurer.

6. Run the OrgChart macro to create an organizational chart from this document.

The macro switches Word to outline view, extracts information from the outline for each level, and 
constructs each level of the chart from this information. The macro then creates a new organizational-
chart document that contains the text from the original document, with each level displayed as a lower 
branch extending from the primary level.



Print Ranges
Prints odd and/or even pages and noncontiguous ranges of pages. When you install this macro, it 
replaces the Print command on the File menu.

Save Screen Size & Position (two macros)
AutoExit runs when you exit Word and saves the current size and position of the screen.

AutoExec runs when you start Word and restores the size and position of the screen saved by AutoExit.

Search Header/Footer
Searches for and replaces text in your document headers and footers.

Table Math
Multiplies, adds, subtracts, divides, and averages values in a Word table. Position the insertion point in a
table cell before you run the macro. To add, average, or multiply a range of cells (such as row 1/column
1 through row 12/column 1), select the Cell Range box. You can also use specific numbers or bookmark
names instead of cell references. The macro inserts the math results in the current table cell as a field. 
The Confirm button verifies the specified cells prior to inserting the formula in the table.

Choose the Option button to specify number and character formatting for the resulting value. For 
example, you can add a dollar sign, a percent sign, a thousands separator, underlining, and a 
positive/negative sign, or you can specify the decimal point place, the alignment, and the color.

True Super/Subscript
Applies superscript or subscript formatting to selected text. The position and size of superscript and 
subscript text is relative to the position and size of the text before you ran the macro. The resulting size 
will be approximately 60 percent of the size of the original.

Concordance Index
Automatically searches through a document for a specified word and marks each occurrence of the word
as an index entry. 

If you install this macro, it will update the previous Concordance Index macro, which is contained in the
NEWMACRO.DOC file included with Word version 2.0 for Windows. To use the updated macro:

1. Open a document for which you want to create an index.

2. From the Tools menu, choose Macro. Under Macro Name, select ConcordanceIndex and then choose
Run.  A dialog box will appear asking for an index word and an index entry.



3. In the Index Word box, type the word or phrase you want to search for in the document.

You can choose to search the entire document for the index word, or you can search a range of pages.
If you want to search a range, type those page numbers in the Page Range section of the dialog box. 
Otherwise, the entire document will be searched.

4. In the Index Entry box, type the word or words you want to appear in your index to reference the 
index word items in the document.

5. Choose the OK button to begin the search and start the index entry insertion. When the macro is 
finished, this message appears:

Operation Completed. Do you want to index another word or phrase?
If you want to run the macro again to index additional items, choose Yes.

6. When you are finished inserting index entries, choose Index from the Insert menu to compile the 
index.

Concordance Index List
Searches through a document for a list of words and marks each occurrence of each word as an index 
entry. The list of words is stored in a separate document that you create before you run the Concordance
Index List macro. You can add Index Entry switch arguments to this list to apply special formatting or 
to create index subentries. Use the Concordance Index List macro instead of the Concordance Index 
macro when you want to index several different words in your document and when you want to 
automatically add formatting instructions to Index Entry (XE) fields.

When you run the Concordance Index List macro, the following dialog box appears:

 
File with index words Type the name of the document that contains the list of words to mark as

index entries. If you don't know the name of the list file, choose the 
Browse button to display a list of files and directories.

Match Upper/Lower 
Case

With this option selected, the macro uses the pattern of uppercase and 
lowercase letters in the index word file as search criteria. If this option is
not selected, the macro finds all instances of the words, regardless of the 
case of the letters.

Page Range If you select the All option button, the macro inserts index entries in the 
entire document. To designate a portion of the document, select the 
From option button and then, in the From and To boxes, type the first 
and last page number of the range in which you want to insert index 
entries.



Save after every... This value specifies the interval at which Word saves the document as it 
marks the index entries. If you receive "Out of Memory" error messages,
type a smaller number for this setting. The default value is 99, which is 
usually an adequate setting.

Index Entry List

The Index Entry list contains the words for which the Concordance Index List macro creates index 
entries. This list may also contain index subentries, range, and formatting information. The Index Entry 
list contains the following information, in the order listed:

Field Information Description

Index Word(s) The word(s) to find and mark as an index entry. This is the Text argument of 
the Index Entry (XE) field if the Entry Word(s) field is blank.

Entry Word(s) The text of the index entry, if different from Index Word. This is the Text 
argument of the XE field.

Range The name of the bookmark that marks the range of pages for the topic. This is 
the bookmark name used with the \r XE field switch.

Bold# If set to 1, applies bold character formatting to the page numbers in the index. 
This corresponds to the \b XE field switch.

Italic# If set to 1, applies italic character formatting to the page numbers in the index. 
This corresponds to the \i XE field switch.

Text for page# The text to print in place of a page number. This text is the argument for the \t 
XE field switch.

The Index Word(s) field is required; the rest of the fields are optional. Use a semicolon (;) or tab 
character to delimit the information. Insert a paragraph mark (¶) at the end of each line. The following 
sample Index Entry list uses a tab character as the delimiter:

' Index Word(s) Entry Word(s) Range Bold# Italic# Text for page#

Microsoft Microsoft ms 1
Word Microsoft:Word 1



Excel Microsoft:Excel 1
Aldus Aldus 1
PageMaker Aldus:PageMaker 1
Micropro Micropro 1 See WordStar
WordStar WordStar 1
FoxPro 1 See Microsoft
FoxPro 2.0 Microsoft:FoxPro 2.0 1
Corel 1
Hewlett-Packard 1
IBM 1
Apple 1
Samna Corp 1 See Lotus 1-2-3
Lotus 1
Lotus 1-2-3 Lotus:1-2-3 lotus 1

For more information on how Word uses this information to generate an index, see Chapter 29, "Indexes
and Tables of Contents," in the User's Guide or consult the Index field topic in online Help.



Index Entry List File Conventions
The table below describes the conventions you should use to create your Index Entry list. The 
INDXWRDS.DOC file, supplied with this Application Note, is a sample data file that uses tabs as 
delimiters and provides custom tab stops. The INDXWRDS.DOT file, also supplied with this 
Application Note, is a Word template you can use to assist you in creating your Index Entry lists.

Delimiter A delimiter is a special character used to separate individual items in a set of data. 
In your Index Entry list, you can use a tab or semicolon to delimit—or separate—
the data fields in each record. In the following example, the first line uses a 
semicolon as the delimiter character, while the second line uses a tab (®) as the 
delimiter:

Microsoft;Microsoft Corporation

Microsoft    ®    Microsoft Corporation

The Concordance Index File macro ignores trailing or leading spaces between data 
items. As a result, the macro produces a correct index entry using the following 
record, which contains extra spaces on both sides of the semicolon delimiter:

Microsoft          ;         Microsoft Corporation

The following examples demonstrate valid Index Entry list records that use either 
semicolons (;) or tabs (®) as delimiters:

Word;Microsoft:Word for Windows;word;1;1;see Word Processing
Word;;;1;1;see Word Processing
Word;Word for Windows;;1;;
Word;;;1;1;
Word;
Word

Word   ®   Microsoft:Word for Windows ® word  ® 1  ®  1  ®  see Word Processing
Word   ®       ®       ®   1   ®   1    ®   see Word Processing
Word   ®   Word for Windows      ®       ®   1    ®    ®   
Word   ®       ®       ®   1   ®   1    ®   
Word   ®   
Word

Note: You must insert delimiters as placeholders when blank fields occur between fields 
that contain data.  When you use the tab character as a delimiter, you can set custom tab 
stops that enhance the readability of your list.

Comments You can insert comments, or explanatory text, in your Index Entry list. To mark 
text as a comment, insert either an apostrophe ('), semicolon (;) or the word rem at 
the beginning of the line. The Concordance Index File macro ignores any line that 
begins with one of these indicators. The following are examples of comment lines:

'   This line is a comment because it begins with an apostrophe.
;   This line is a comment because it begins with a semicolon.
rem This line is a comment because it begins with rem or REM.



The first line in the INDXWRDS.DOC file, supplied with this Application Note, is 
a comment that lists the name of each field in your Index Entry list:

' Index Word(s) Entry Word(s) Range Bold# Italic# Text for page#


	ANSI Char
	App Runner
	Bookmark Helper
	1. You can list the contents of all bookmarks in a document.
	You can list bookmarks in the order in which they appear in the document, in alphabetic order by bookmark name, or in alphabetic order by their contents.

	2. You can search for a bookmark name or its contents.
	The macro will list all instances in the order in which the bookmarks are found in the document.


	Print Listed Documents (two macros)
	Glossary Manager
	1. In the Source Template list, select the template that contains the desired glossary entries. If you select a different template, choose the Refresh List button to update the Glossaries In Source Template list.
	2. In the Destination Template list, select the template into which you want to copy or move the selected glossary entries.
	3. In the Glossaries In Source Template list, select a glossary entry name. Choose the Select button. An asterisk (*) appears next to selected glossary entries. To select all the glossary entries in the list, choose the Select All button. To clear a single selection, select the glossary entry and choose the Clear button. To clear all selected glossary entries, choose the Clear All button. Repeat this step until you have selected all the desired glossary entries in the Glossaries In Source Template list.
	4. Choose one of the following buttons:
	5. Choose the Exit button to close the Glossary Manager macro.

	Org. Chart
	1. In a new document type the following (end each line with a paragraph mark):
	President Vice President Secretary Treasurer

	3. Apply the "Heading 1" style to President.
	4. Apply the "Heading 2" style to Vice President.
	5. Apply the "Heading 3" style to Secretary and Treasurer.
	6. Run the OrgChart macro to create an organizational chart from this document.

	Print Ranges
	Save Screen Size & Position (two macros)
	Search Header/Footer
	Table Math
	True Super/Subscript
	Concordance Index
	1. Open a document for which you want to create an index.
	2. From the Tools menu, choose Macro. Under Macro Name, select ConcordanceIndex and then choose Run. A dialog box will appear asking for an index word and an index entry.
	3. In the Index Word box, type the word or phrase you want to search for in the document.
	You can choose to search the entire document for the index word, or you can search a range of pages. If you want to search a range, type those page numbers in the Page Range section of the dialog box. Otherwise, the entire document will be searched.

	4. In the Index Entry box, type the word or words you want to appear in your index to reference the index word items in the document.
	5. Choose the OK button to begin the search and start the index entry insertion. When the macro is finished, this message appears:
	Operation Completed. Do you want to index another word or phrase?
	If you want to run the macro again to index additional items, choose Yes.

	6. When you are finished inserting index entries, choose Index from the Insert menu to compile the index.

	Concordance Index List
	
	Index Entry List
	Index Entry List File Conventions
	Microsoft;Microsoft Corporation
	Microsoft ® Microsoft Corporation
	Microsoft ; Microsoft Corporation
	'   This line is a comment because it begins with an apostrophe.
	; This line is a comment because it begins with a semicolon.
	rem This line is a comment because it begins with rem or REM.




